
Workshop Topic 
Dealing with Roofs

Roofs for standard houses are easy, 
but what if you don’t want a standard 
roof. This workshop will cover how 
to create a standard roof, how to edit 
a standard roof and what yo do when 
the standard roof won’t do what you 
want. 

Q & A 
How can I use an iPod as a 
backup device?

I’ve told a lot of people that they 
should get an iPod. You can use it for 
back-up and storage. So which iPod 
should you get and how do you set it 
up for storage. 

Extended Podcast 046

VectorWorks 2008 has a new plan 
view, the Rotated Plan view. This is a 
long requested feature and should be 
really useful for buildings that have 
wings at different angles..

Extended Podcast 047

The Stacked layers view looks like 
it gets rid of the need to use layer 
linking. I think it is a useful feature, 
but you still to learn layer linking.

 

c a d s u p p o r t o n l i n e . c o m  issue 0710

This newsletter is designed to work as an on-line user group. It is based on the successful New Zealand VectorWorks User 
Group format, where each month we cover a main topic in a workshop then have a page of general questions and answers. 
In this news letter you will find a link to the workshop topic, a link to the questions and answers and links to extended 
podcasts (tips and trick movies). 

http://learn.archoncad.com/?p=1474
http://learn.archoncad.com/?p=1477
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•	 Fill in the details for the 
roof. 

•	 Note, if the roof 
overhang is too big, 
VectorWorks will have 
trouble making the roof. 

•	 Click on the OK button. 

•	 Here is the warning that 
the roof is in trouble. 

•	 Click on the OK button. 

•	 This is what you get if 
the roof doesn’t work 
for you. It is not a 
disaster to have the roof 
end up like this. You 
can still save it.

Creating Roofs

cadmovie083

There are two main ways to create roofs:

1. Creating a roof from selected walls;

2. Creating a roof from a selected polygon.

•	 Open a file with walls. 
•	 Select all the walls.

•	 Go to the Menu Bar.
•	 Choose 

AEC > Create Roof...
	 (If you are using the standard workspace 

use 
Model > AEC > Create Roof...)

D e a l i n g  W i t h  R o o f s

http://learn.archoncad.com/?p=1482
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•	 Move to the next handle 
on the roof that you 
want to delete.

•	 Click once. 

•	 Now you have a decent 
roof. 

The other method is to create a polygon that it is the correct shape for the 
roof. You can use that to create the roof from. It saves the editing after the 
roof creation. 

•	 Go to the Basic tool set.
•	 Select  the 2D Reshape tool. 

•	 Go to the Mode bar.
•	 Click on the 4th mode. 

•	 Move to a handle on the 
roof that you want to 
delete.

•	 Click once. 
VectorWorks will re-
calculate the roof. 
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Editing Roofs

cadmovie084

Gable Roof
Once a roof is created you can edit parameters of the roof, roof plane 
by roof plane if you want, or the entire roof. We are going to create a 
split gable roof using the standard roof command, and some simple 
editing.	

•	 Select the roof using the 
2D Selection tool.  

•	 When you create a roof 
the result is always a 
hip roof but we want a 
split gable.  

•	 With the 2D Selection 
tool move the cursor 
over the handle at the 
right hand side of the 
roof.  

•	 When you do, the 
cursor will change into 
a hand.  

•	 Click on the handle to open the 
Edit Roof dialog box.

•	 Click on the Gable radio button.
•	 Fill in the settings that you want. 
•	 Click on the OK button.  

• The result is a gable end.

•	 With the 2D Selection 
tool move the cursor 
over the handle on the 
far left hand side of the 
roof.

http://learn.archoncad.com/?p=1484
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•	 Click on the handle to open the 
Edit Roof dialog box.

•	 Click on the Gable radio button.
•	 Fill in the settings that you want. 
•	 Click on the OK button.  

•	 Now you a gable roof.

Split Gable
cadmovie085

We are going to create a split 
gable roof using the standard 
roof command, and some 
simple editing.	

•	 Select the roof using the 
2D Selection tool.  

•	 With the 2D Selection 
tool move the cursor 
over the handle on the 
left hand roof face.  
When you do this, the 
cursor will change into 
a hand.   

•	 Click on the handle 
to open the Edit Roof 
dialog box.

•	 Click on the Gable radio button.
•	 Click on the OK button.  

•	 VectorWorks has 
created the split gable 
roof.

http://learn.archoncad.com/?p=1486
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One Gable
cadmovie086

We can continue to edit our 
roof further. You can edit the 
roof in 2D or in 3D. 	

•	 With the 2D Selection 
tool move the cursor 
over the handle on the 
left hand roof face.  
When you do this, the 
cursor will change into 
a hand.   

•	 Click on the handle to 
open the Edit Roof dialog box.

•	 Click on the Gable radio button.
•	 Click on the OK button.  

•	 You can see the roof in 
3D. 

Mono Pitch Roof
cadmovie087

A mono pitch roof is popular 
at the moment. Surprisingly, 
you can keep the roof as a 
standard VectorWorks roof. 	

•	 Select the roof using the 
2D Selection tool.  

•	 Move to the roof handle 
at the bottom right.

•	 Click once. 

•	 Click on the Gable radio button.
•	 Click on the OK button.  

http://learn.archoncad.com/?p=1492
http://learn.archoncad.com/?p=1494
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•	 This roof has gable end 
walls under it. You can 
leave them if you want.

•	 I prefer to remove the 
gable end walls. They 
are controlled by the 
Object Info Palette. 

•	 Use the Object Info Palette to turn off the gable end walls. Use the 
Fit Walls to Roof... command to extend your walls up to the roof. 

•	 This makes a mono-
pitch roof. 

•	 Move to the handle at 
the last eave, the one at 
the top left. 

•	 Click once. 

•	 Change the roof angle.
•	 Click on the OK button.  
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How To Insert a Dormer Window
To insert a dormer window you need to create the roof first and you need 
a window or door symbol to insert. You cannot use a plug-in object like 
a simple window to create a dormer.  You can however use the simple 
window plug-in to create the symbol.  

cadmovie088

•	 You need a file with 
a roof and a window 
symbol. The window 
has to be asymbol to use 
it as a dormer window.  

•	 On the Resource Browser find the 
window symbol.	

•	 Double click on the window symbol.

•	 Move your cursor over 
to your roof where 
you want the dormer 
window.  

•	 Click once. 

•	 This will open the Edit Roof 
Element dialog box.

•	 Choose the type of dormer that 
you want to use.  In this case we 
have chosen the gable dormer.

http://learn.archoncad.com/?p=1496
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•	 Use the ‘Offset From Top’ radio 
button to accurately control 
where you want the centre of 
your window or door symbol to 
be in the wall.

•	 The building line offset is used 
to control the position wall 
containing the dormer window 
in relation to the wall or polygon 
that you used to create the roof.  
This should be set to zero or ‘0’ 
if you want to line up with the 
walls below.

•	 Note that by default the left slope and the right slope of the dormer 
are at 45º.

•	 The roof thickness of the dormer window is controlled by the 
Object Info Palette. Change these later. 

•	 When you are happy about the parameters, you can click on the 
OK button to close the dialog box.

•	 VectorWorks makes 
your dormer window.

•	 When you select the 
roof you get blue 
selection handles on 
each roof face and at the 
bottom centre of each 
dormer.  

•	 The Object Info Palette controls the 
dormer roof thickness and dormer roof 
wall thickness.  

•	 Edit the wall thickness and roof thickness  
to suit your construction. 

•	 To edit a dormer 
window, click on the 
handle at the bottom 
centre of the dormer 
window. 



©Jonathan Pickup	 cadsupportonline  - Issue 0710

Page 10

•	 This will open the Edit Roof 
Element dialog box.

Change the parameters that you 
want to and then click OK.  

•	 You will be taken back 
to your drawing and the 
changes you made will 
be applied to the dormer 
and roof.

•	 To delete a dormer window that 
has been placed, move your 
cursor on top of the handle for 
the dormer that you want to edit 
and click once.

•	 This will open the Edit Roof 
Element dialog box.

•	 Click on the Remove 
Object check box and 
then click OK.

•	 You are returned to the 
drawing area and the 
roof is regenerated, and 
the dormer window is 
deleted from the roof.

How to Insert a Skylight
Putting in a skylight is similar to putting in a dormer window.  To place 
a skylight you need to create a skylight symbol.  The way that you create 
the skylight is crucial to the way it inserts into the roof.	

When you create a symbol for the skylight the insertion point of the 3D 
Symbol is used to relate the skylight to the face of the roof. The symbol 
cannot be a hybrid symbol.   It must be 3D only.   Create an extruded 
rectangle the size that you want, the actual size of the skylight that you 
want to create.	

cadmovie089

•	 Change to a Top/Plan view.
•	 Go to the Resource Browser.
•	 Double click on the skylight symbol.
•	 Click on the roof where you want the 

skylight to be.  

http://learn.archoncad.com/?p=1498
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•	 Click on the button for Edit 
Skylight.

•	 On this dialog box you can 
control the position of the 
skylight on the roof.

•	 Your skylight symbol has been 
installed.  

•	 You can edit the 
skylight after you have 
created it by editing the 
symbol.

•	 If you change to a 3D 
view you can see the 
skylight in the roof.

•	 You can change some of the skylight 
settings on the Object Info Palette. 

•	 Change the skylight pop-up menu to 
Splayed.

•	 This will change the 
way the roof reacts with 
the skylight.

•	 You will notice that you 
get selection handles on 
each roof face and at the 
bottom centre of each 
skylight.  
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•	 Move your cursor 
over the handle for the 
skylight that you want 
to edit.

•	 Click once. 

•	 This will open the Edit 
Roof Element dialog box.

•	 Change the parameters.
•	 Click on the OK button.

•	 The skylight moves to 
the new settings.

•	 To delete a skylight, 
move your cursor 
over the handle for the 
skylight that you want 
to remove.  You will 
notice that the cursor 
changes to a hand. 

•	 Click once to open 
the Edit Roof Element 
dialog box.

•	 Click on the Remove Object 
check box 

•	 Click on the OK button.

•	 You are returned to the 
drawing area, the roof 
is regenerated and the 
skylight is deleted.
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Cut Out in a Standard Roof
If you don’t want to go to the trouble of creating a 3D symbol for the 
skylight, you can punch a simple hole in the roof face.  VectorWorks calls 
these holes a cut out.	

cadmovie090

•	 Change to a Top/Plan 
view.  

•	 Select the roof using the 
2D Selection tool.  

•	 Go to the Menu bar.
•	 Choose  

Modify > Edit Group.

•	 This takes you inside 
the roof group and all 
the roof lines go grey.  

•	 Make sure that you 
draw a ‘shape’ not 
just lines.  This means 
that you have to draw 
a rectangle, circle or 
polygon.

•	 Draw a rectangle.

•	 Click on the Exit 
Group button at the 
top right corner of your 
drawing window.  

•	 You are back to the 
main view of your roof.

http://learn.archoncad.com/?p=1500
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•	 The cut out can be seen 
in 3D if you render the 
view.

•	 To remove a roof cut 
out, select the roof .

•	 Go to the Menu Bar.
•	 Choose 

Modify > Edit Group.

•	 Select the object that 
creates the cut out.

•	 If you use your 2D 
Selection  tool you can 
drag a marque around 
the object you want to 
select.

•	 Delete the rectangle.  

•	 Click on the Exit 
Group button at the 
top right corner of the 
drawing window.

•	 You are returned to 
model. VectorWorks has 
updated the roof. 
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Roof Accessories
cadmovie091

•	 Change to a Top/Plan 
view.  

•	 Select the roof using the 
2D Selection tool.  

•	 Go to the Object Info palette.
•	 Click on the  

Soffiit Settings button. 

•	 Fill in the settings...

•	 Go to the Object Info palette.
•	 Click on the  

Insert Soffiit button. 

•	 VectorWorks adds the 
soffit to your roof.

•	 Go to the Object Info palette.
•	 Click on the  

Fascia Settings...

http://learn.archoncad.com/?p=1502
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•	 Fill in the settings...
•	 Click on the OK button. 

•	 Go to the Object Info Palette.
•	 Click on the  tick box for 

Insert Fascia.

•	 VectorWorks inserts the 
Fascia

•	 If you ungroup the 
roof, you can change 
the colour and textures 
on the fascia and soffit 
separately.

When You Can’t Edit The Roof Enough
There are times when the editing that you can do to the roof is not enough.  

For example:	

-	 A roof that spans 2 floors may not work out correctly.  The ridge 
may not be where you wanted it or the junction between the two 
roof faces may not be where you want it.

-	 When you want to put in ridges at a different place to where the 
standard roof wants to put them.

For these situations it is best to take the standard roof just as far as you 
can.  The standard roof makes it so easy to put in dormers and skylights 
that you should really use it as much as you can. When you can’t use the 
standard roof editing any more but you still want to edit the roof, it’s time 
to ungroup the roof and edit the individual faces manually.	
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Intersecting Roofs

This exercise will show you how to find the intersection of two roofs. 

cadmovie092

•	 You need a  flie with 2 
roofs.  

•	 Select both roofs.

•	 Go to the Menu Bar.
•	 Choose Modify > 

Convert > Convert Copy to 
Lines...

•	 Choose Hidden Line 
Rendering.

•	 Click on the OK Button.

•	 The result is a group of lines. If you make the 
lines heavy it will help you to see the lines. 

•	 Use the Attributes Palette to make the lines 
very heavy. 

•	 Now the intersection 
lines are easier to see. 

•	 Go to the Basic Toolset.
•	 Select the 2D Polygon Tool. 

http://learn.archoncad.com/?p=1504
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•	 Start at the intersection 
of the two roofs, at the 
eaves. The end of the 
heavy line is where the 
two roofs intersect. 

•	 Click once. 

•	 Move to the end of 
the heavy line at the 
ridge. The heavy line 
stops where the ridge 
intersects with the other 
roof. 

•	 Click once. 

•	 Move the roof eave, 
where the heavy line 
stops.

•	 Click once. 

•	 Move the end of the 
roof.

•	 Click once. 

•	 Move to the other end 
of the roof.

•	 Click once. 

•	 Move back to where 
you started. 

•	 Click once. 
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•	 You have a polygon. 
We’ll need this to cut 
out the roof.

•	 Right mouse click on 
the polygon.

•	 Choose Cut.

•	 Use the 2D Selection 
tool to select the heavy 
group of lines.

•	 Delete the group. It has 
done its job and we 
don’t need it any more.

•	 Select the smaller roof.

•	 Go to the Menu bar.
•	 Choose  

Modify > Edit Group.

•	 Go to the Menu bar.
•	 Choose  

Edit > Paste in Place
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•	 Your Polygon is pasted 
on top of the roof.

•	 Click on the Exit Group 
button at the top right of 
the drawing area.

•	 Now you can see 
the roof has been 
recalculated.

•	 Notice that part is 
missing. 

•	 If you change to a 3D 
view you can see how 
the roof has been cut 
out. 

Roof Face

A roof face is an old VectorWorks concept. We used to have roof faces 
before we had a complete roof. We would make a roof out of several 
roof faces. A roof face is one part of the roof, what you might call a roof 
plane. A roof face is a hybrid object. VectorWorks takes a 2D roof plane 
and projects it to 3D. 

Create Roof Face by Angle

cadmovie093

•	 Change to the Exercise 
3 layer.  

•	 To create a roof face, 
select the rectangle with 
the 2D Selection tool.  

•	 Go to the Menu Bar.
•	 Choose Model > AEC > Roof 

Face...  

http://learn.archoncad.com/?p=1506
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•	 This opens the Create 
Roof Face dialog box.

•	 Make the roof face using 
the Angle radio button.

•	 The Axis Z is the height 
to the roof pitch line 
from the bottom of the 
current layer.This has 
no relation to the project 
height.  It is the height in 
the current layer.

•	 Angle is the angle of the 
roof.

•	 Fill in the settings that 
you want. 

•	 Click on the OK button.

•	 Now you define the 
axis line (the pitch 
line).  Keep your eye 
on the mode bar for this 
command.  It tells you 
what to do.

•	 To define the axis line, 
move the cursor to the 
top left corner of the 
building.  When the 
screen hints tell you that 
you are at the corner of 
the building click once.

•	 Now move down to 
the end of the roof 
axis.  When the screen 
hints tell you that you 
are at the corner of the 
building, click once.  

•	 The last thing to do 
is to define the high 
side of the roof.  Move 
the cursor to the right 
and you will notice a 
big black arrow that 
points to the right.  This 
indicates the high side 
of the roof.

•	 Click once.

•	 The roof face is created 
and is brought to the 
front.
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•	 In 3D...

Create Roof Face by Rise 
Over Run

Creating a roof by rise over 
run is similar to the create 
roof by angle.  The only 
difference is that instead of 
typing in the angle you give a 
run - a horizontal length and a 
rise for the run.

Create Roof - Peak Height 
Above Axis
This option is under used but very useful when you know the height to 
the ridge (peak) above the axis (pitch line).

Cut Out in a Roof Face
If you know accurately where you want the roof cut out, you could do it 
before you create the roof face.

Cut Out After You Have Made the Roof Face

The other way to create the cut out in the roof face is when you have 
already created the roof and then you want to punch a hole in it. This 
technique is exactly the same as creating the cut out in a standard 
VectorWorks roof. 

Curved Roofs

VectorWorks can’t really make a curved roof. If you want a curved roof 
you have to create an extrusion for the curved part of the roof. 
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Q u e s t i o n s  a n d  A n s w e r s

Q.  “How can I use an iPod as a backup device? ”

I’ll answer the first part of this question first. I think the iPod is a great 
little device. Not just for carrying around your music, but you can also 
use your iPod for backing up files or for copying files from one machine 
to another. 

Step 1

You need to buy an iPod. 
There are a few to choose 
from, but which one 
should you get?

How much do you need to 
store?

You need an iPod that has 
some storage, so that rules 
out the iPod Shuffle. 

If you want a small iPod that has modest storage, get an iPod Nano.

If you want slightly more storage, but you want a beautiful thing, get 
the iPod Touch. It’s a wonderful thing to play with, but it still has only 
modest storage.

For a decent amount of storage you need the iPod Clasic. It comes 
with 80GB or 160GB of storage. You could get the 160GB model, put 
thousands of songs on it and not even use one half of the storage. 

Step 2

With an iPod you use iTunes to copy music, photos, movies and calen-
dars. When you choose the things to copy you can also enable the use of 
the iPod for file storage. 

You have to tick the option 
for Enable Disk Use. 

When you check this and 
connect your iPod, it turns up as a 
connected hard drive on your desktop. 

Now you can treat the iPod as backup 
device. 

I have ordered the cables I need to connect my iPod to a TV. When they 
arrive I will show you how to connect for presentation. 


